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We want you to use our software, not let it sit on a
shelf. If you have trouble, please re-read the relevant
section of the documentation. If it used to work but
doesn’t any more, try making a new working copy
from your MichTron original.

If neither the documentation nor the new copy help,
we'll be glad to. But we much prefer that you write or
use our bulletin board, rather than call. It's likely you'll
get an answer as fast over the bulletin board as over
the phone. We answer bulletin board messages the
first thing every morning; we even answer our mail the
day it comes in. A telephone call is faster only if the
right person happens to be in our office when you call.
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A word about error messages

Mighty Mail handles most errors internally, so you'll
rarely see an error message. Most error messages
give explicit instructions on what to do. Should you
encounter a message that asks you to contact
MichTron, write down all the numbers and names
listed, then use ma:l our bulletin board or the
telephone to tell us o /y ur problem. The data from
the error message will be helpful to us in tracking
down what went wrong.
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INTRODUCTION

Throw away those piles of addresses on torn slips of paper,
quit typing labels one by one at your typewriter, quit poring
over customer lists to find the ones you want to send the
current mailing.

Instead, let Mighty Mail do the work for you.

Just type that mailing list once more - to create your Mighty
Mail address file. There’s room for a company name, 2
person’s first and last names, two street address lines, city,
state and zip code and a telephone number. And there are
16 user-defined flags to mark the special characteristics of
‘your customers.

You can add new names or new files of names any
time. A single-sided disk will hold about 1,400
addresses, but if you have a hard disk, you could
store as many as 65,000.

Once you’ve got the names in, Mighty Mail takes over.

Design your labels with a simple point-and-click graphics
screen. Store as many different label layouts as you
You may place al the customer data anywhere you want
within a label whose size you define.

Review the records in company, personal name or zip code
order.

And print selected lists keyed on your user-defined flags, on
alphabetical sorting on any data fields, or on any
combination of fields and flags.

Mighty Mail even weeds its files of duplicate entries at

your request. Once you get Mighty Mail on the job, your
worst mailing problem will be licking stamps fast enough.
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Making a working copy

Before you run Mighty Mail for the first time, copy all the
files on’your original MichTron disk to your own formatted
disk. Refer to your Atari owner’s manual for instructions
on copying files from one disk to another.

The fllcs o'nyour disk should be MAIL PRG (MAIL.APP if

the M ion), SAMPLE.IDX,
SAMPLE MAL DEFAULT. LBL DEFAULT REP and,
possibly, READ.ME. The last, if it exists, contains updat:s
you should know about before you use the program.
SHOW or PRINT it; make notes in this manual.

Put your MichTron original disk in a safe place. Use your
copy for everyday operations.

Loading Mighty Mail

Boot up your computer, select Medium or High resolution,
and insert the disk with your Mighty Mail copy into a disk
drive. Double-click on the appropriate drive icon to get a
directory if necessary. Move the pointer to the MAIL.PRG
icon or label. Double-click to start the program.

You’ll see the Mighty Maillabel and the opening window
of the Mighty Mail program. Drag open one of the pull-
down menus and select an option to begin.

Hardware requirements

Mighty Mail requires an Atari ST series or IBM-
compatible computer running under GEM with monitor,
printer and at least one disk drive. Printing reports will be
more convenient if your printer is designed to deal with
continuous-form labels.
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GETTING STARTED

‘When you’ve loaded your working copy of Mighty Mail,
you’ll see the opening screen with five pull-down menus.

At the left is the Desk menu, with access to whatever
accessories you may have loaded on your Desktop. (Once
you've loaded a working file, its name will appear here
instead of Desk.)

The options on the File menu help you enter information,
inspect or change information, change the order of data in
the file, switch to another file, import new files, export your
own files, weed duplicates from your lists and quit the
program. You'll also be able to mark the data with any of
16 user-defined flags.

Each time you start Mighty Mail, you’ll first use the
File menu to pick a work file, then pick another option.

The Layouts menu helps you design your own label styles
to fit your label stock and print the data in whatever
arrangement you like. You may also design lists of
customer data with page headings and re-use layouts.

The Masks menu helps you set up criteria to pick certain
addresses from the whole list to be printed. You’ll be able
to chose items to print by alphabetical sorting on any data
field, on the on/off setting of any of the 16 user-defined
flags, or on any combination.

The Printer menu directs printing labels or reports. You
may choose to print test labels, print to a file or print on
your printer using layout and selection cues chosen using
the Layouts and Masks menus.

Your MichTron disk includes a sample file you should
work until you see how to use the program.
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USING THE MENUS

Using the Desk menu

‘When you drag open the Desk meny, you’ll sce the Mi-Mail
Info option and those desk accessories you have loaded. To
see the version information for your copy of Mighty Mail,
click on the Mi-Mail Info option. Click on OK or press
RETURN to retum to the main menu.
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Using the File menu

‘When you drag open the File menu, you’ll see a set of eight
options to choose from. These help you enter and modify
data, change its order, eliminate duplicates and quit the
program.

Layouts Masks Printer

Click on one of the options to begin work on your files.
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Opening a file

Each time you use Mighty Mail, you’ll first use this option
to select an address file o work with. You may have as
‘many separate address files as you like, though the poy

sorting functions make more than one superfluous B ‘many
people. You might want separate address files for different
businesses, or a personal and a business file.

When you click on this option, the screen will show a
standard GEM item selector. Listed on the directory will be
all files with exlenslon .MAL on the default disk drive, the
drive from which you’ve loaded Mighty Mail.

oLE Lasouts_Hasks _printer

e SELECTOR

Directary
NILK,
Selection:
SRUPLE L]

To choose a listed file

To choose one of the listed files, click on its label, then on
OK, or double-click on the file label. Mighty Mail will
open the specified file, and shift to View mode to display its
first record.
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To choose a file not listed

If the file you want to use is on another disk drive, click
once on the directory line at the top, then type in the right
disk drive designation, using the usual GEM editing keys.
Click once on the folder identifier move bar to see the files
in the newly chosen folder.

If the file you want is contained within a folder in the
current folder, double-click to open the folder. You may
open as many folders within folders as necessary.

To create a new file

To create a new file, just type the new name into the
selection line at the right of the item selector. Then click on
OK'to open the new file. As for an old file, Mighty Mail
will open the new file open and display is first (blank, of
course) record.
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Viewing a file’s contents

‘When you choose this option, you’ll see the first record in
the file now open displayed with a set of selector buttons.

On the left is the data: company name, personal last name,
personal first name, two address lines, city, state, telephone.
‘number and zip code.

You may change any of the data by typing and using
the usual GEM cditing keys. Exception: If you press
RETURN, the cursor advances from field o field.

At the bottom you'’ll see the 16 user-defined flags, shown as
on/off selector buttons. (To define the flag labels, you’ll
need to use the Flag Description option under this menu.)

‘You may change the status of any flag from off (normal
video) to on (reverse video) or vice versa by clicking
on the selector button.

At the réght you'll see the View functions: SEARCH

MASK, SE; NEXT, SHOW BY, DELETE, GET
PREVIOUS, GET NEXT and EXIT.
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SEARCH MASK

When you click on this function from the View option or
press the F7 key, you'll see a screen much like the View
screen, but tions at the right will be limited to

1€ O]
CANCEL and ACCEPT and the central stripe across the
screen will be Iabeled Search Mask.

Search Hask

The record display will show the last search mask you’ve
used. To search for a record with a particular characteristic,
just enter that characteristic and make the rest of the record
blank, using the GEM editing keys. (If you press
RETURN, the cursor will move from field to field.) Click
on ACCEPT or press CTRL-RETURN to start the search.

If you want to search based on a combination of
features, enter all the features you're looking for.

As soon as you click on ACCEPT, the search will begin,
stopping at the first record that matches your search mask.
That record will be displayed in the View format. Should
there be no matches, you'll see across the central stripe the
message, in reverse video, Last Record, No More
Matches.
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Setting up the mask

‘With your mask, you may try to match any of the typed
data, any of the flags set to on or any combination of both.

For instance, you could search for those on your list
with last name Murphy to whom you had sent the last
catalog. You would type the name Murphy into the
personal last name field of the record image and click
on the flag, say number 6, that represents the recipients
of the last catalog. When you click on the ACCEPT
selector button, Mighty Mail would search for the first
record in which the personal last name was Murphy
and the setting of flag 6 was on.

Fields left blank and flags left turned off are ignored in the
search. You may combine as many search criteria as you
like - multiple flags, for instance, or name of company and
zip code. Usually just one or two specifications will be
enough to find the record you want quickly.

You may use the special characters ?and *in the typed
fields if you like.

The question mark represents & single character that
will be ignored in trying to make a maich. For
instance, if you can’t recall whether the man whose
phone number you want spells his name Reed or Reid,
you can find him by typing Re?d into the name field.

The asterisk represents any number of chanu:wrs that
will be ignored in trying to make a ma (The
asterisk is like a string of question marks) For
instance, if you can recall only that the salesman’s
name bl%gan ‘with K, you can find him in your file by
typing K* into the name field.
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SEARCH NEXT

If the first match found by the search mask order isn’t the
right one, click on SEARCH NEXT or press the F2 key to
get Mighty Mail to find the next record that matches’ the
search mask you just set up. When a match is found, yow’ll
see the record displayed in the View format just as you did
with SEARCH MASK. Should there be no further match,
you’ll see the Last Record, No More Matches message
across the center of the screen.

SHOW BY

When you choose this function from the View display or
press the F3 key, you’ll see an alert box pop up. The box
will offer you the choice of sorting your records by
company name, by personal last name or by zip code. The
current choice is noted by a check box in reverse video.

Click on the box corresponding to the order you want.
Then click on OK to change the order to the one specified
or on CANCEL to retain the previous order. The alert box
will close and you’ll be returned to the View screen.

DELETE

To remove the record displayed on the View screen, click
on the DELETE selector buiton or press the F4 key. An
alert box will ask you if you want to delete this record.
Click on YES or NO as appropriate.

If you click on YES, the record will be deleted and
yow’ll be returned to the View screen with the next
Tecord in the current order displayed.

If you click on NO, youw’ll be returned to the View
screen with the same record still showing.
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GET PREVIOUS

‘When you click on this selector button, press the F9 key or
press SHIFT-LEFT ARROW, Mighty Mail will show
you, in View format, the record just before the current one
in the current sort

If the current record is the first in the file, you’ll see the
message First Record written in reverse video across
the central stripe.

GET NEXT

When you click on this selector button, press the F10 key
or press SHIFT-RIGHT ARROW, Mighty Mail will show
you, in View format, the record just after the current one in
the current sort order.

If the current record is the last in the file, you’ll see the

message Last Record written in reverse video across
the central stripe.

EXIT
When you click on this selector button, you’ll be retuned to

the main menu. You may also exit from the View option by
pressing CTRL-RETURN.
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Adding records to a file

‘When you want to add new records to your address files,
click on the Add option from the File menu. You'll see a
screen much like the View screen, but the selector buttons
at the right will be limited to INSERT and DONE. You’ll

o see the reminder message Insert Mode written in
reverse video across the central stripe on the screen.

Tnsert node

Once you see the Add screen, just type in the data for the
new record, using the usual GEM editing keys. Exception:
I.fyou press RETURN, the cursor will advance to the next

Click on any flags that should be set for the new
rewrd When you have checked that the data you've typed
is correct, click on the INSERT button or press CTAL-
RETURN. The new record will be added to the current
working file and youwll be presented with a fresh Add
screen, ready for the next new entry.

If part of your data is the same, or if you want to set flags
for the new entries, you can get Mighty Mail to do the
repetitive work. See Autotypes, part of the Masks menu.
When you’ve typed in all the new entries, click on the
DONE selector button. You’ll return to the File menu.
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Changing the order of a file

‘When you click on the Order option under the File menu,
you’ll see an alert box pop up to ask you in what order to
arrange your data file. The current order will be marked
with a reverse-video selector box.

Shox or Print 8y

congany
Last hane
Zip tode

To change the order used, click on the new order you want
and click on OK. To leave the order as it was when you
chose the Order option, click on CANCEL or press
RETURN.

You’ll return to the File menu.

Mighty Mail - Page 18



Deleting duplicate records

When you click on the Del Dups option under the File
menu, you'll see a screen split vertically into two record
displays, with DELETE buttons at the base of each. Below
%eE );};_xee other selector buttons, AUTO, CANCEL and

Delete Duplicates

Gonpany: Purves Computer Syst | Company: Purves computer sst |

Kane: purves Tinothy | hane: purves T

ddress: 123 river road Rddress: 236 river road
1ty ontiac citar pentioe
iswten isteni zipt
e ot User date:

On the left you’ll see the first record of the current working
file in the current sort order. The right-hand side will be
blank until the first apparent duplicate is found.

Mighty Mail automatically makes two passes through your
file looking first for matches. The search begins and ends
automatically.

On the first pass, Mighty Mail 1ooks for records which
have common company and personal last names. On
the second pass, Mighty Mail looks for records with
common personal last name, first letter of personal first
name, and zip code.
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Deleting a duplicate record
‘When Mighty Mail finds an apparent duplicate, it displays

both records, including flags set. You may delete either
record by clicking on the appropriate DELETE button.

Retaining an apparent duplicate

If you want to retain both records, click on NEXT or press
CTRL-RETURN. Mighty Mail will move on, looking for
another match.

Using automatic duplicate deletion

If you want Mighty Mail to automatically eliminate the
duplicates it finds without asking you about each apparent
‘match, click on AUTO.

Halting the search for duplicates

If you want to stop the deletion of duplicates and refurn to
the main menu, click on CANCEL.

You may also s FE’_the search for duplicates by holding
down either SHIFT key or the mouse button until the
program stops.

When you stop the search or Mighty Mail finishes testing
for matches, you’ll return to the main menu.
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Importing a file

You may use the Import option from the File menu to add
not just individual records, but whole files to your current
file. When you click on this option, you’ll see an item
selector box that will list the files on the default drive.

e seLecTor

Directory:
ALK

o

To choose a listed file

To import one of the listed files, click on its label, then on
OK, or double-click on the file Iabel. Mighty Mail will
insert the specified file into the current working file. The
records of the imported file will automatically be sorted into
their proper order in the current working file.
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To choose a file not listed

If the file you want to import is on another disk drive, click
once on the directory line at the top, then type in the right
disk drive designation, using the usual GEM editing keys.
Click once on the folder identifier move bar to see the files
in the newly chosen folder.

If the file you want to import is contained within a folder in
the current folder, double-click to open the folder. You may
open as many folders within folders as necessary.

‘When you find the right file, click on its label, then on OK,
or double-click on the file Tabel. Mighty Mail will insert
the specified file into the current working file. The records
of the imported file will automatically be sorted into their
proper order in the current working file.

An alert box will count off the records as it imports them so
you can keep track of progress. You may stop the import
by holding down either SHIFT key or the mouse button
until the program stops.

See the format note following the description of the
Export option.
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Exporting a file

You may send all or part of your data file to another file by
clicking on the EXport option under the File menu, When
you click on this option, you’ll see an item selector box that
‘will list the files with extension .EXP on the default drive.

To choose a listed file

To export the working file to one of the listed files, click on
the label of the destination file, then on OK; or double-click
on the file label. Mighty Mail will export the current
working file to the specified file. If the destination file is
not empty, you’ll be asked whether you want to overwrite
the current contents of the destination file. Click on YES or
NNO as appropriate.

An alert box will count off the records as it exports them so
you can keep track of grogxcss. You may stop the export by
holding down either SHIFT key or the mouse button until
the program stops.
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To choose a file not listed

If the file you want to send your working file to is on
another disk drive, click once ‘on the directory line at the
top, then type in the right disk drive designation, using the
usual GEM editing keys. Click once on the folder identifier
move bar to see the files in the newly chosen folder.

If the file you want to export to is contained within a folder
in the current folder, double-click to open the folder. You
may open as many folders within folders as necessary.

When you have found the right disk drive and folder,
double-click on the file label or click once each on the file
label and OK to start the export. Mighty Mail will export
the current working file to the specified file. If the
destination file is not empty, you’ll be asked whether you
want to overwrite the current contents of the destination
file. Click on YES or NO as appropriate.

An alert box will count off the records as it exports them so
you can keep track of grogress. “You may stop the export by
holding down either SHIFT key or the mouse button until
the program stops.

See the format note on the next page.
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Setting up the Mighty Mail format

Except for import and export of files, you’ll never need to

think about the internal structure of Mighty Mail files.

That structure is quite simple: Data is stored sequentially,

separated by commas within each record and by a carriage
return/line feed combination between records.

‘When you export a file, Mighty Mail places double
quotes around each piece of data, inside the commas.

import, the double quotes are opuona.l except
around imbedded commas in the

The sequence of data within a record is:

Personal last name, personal first name, company,
address line 1, address line 2, city, state, zip code,
telephone number, (16 flag codes, each separated by
commas), carriage return/line feed.

you are importing data, make sure before you read it into
a M:ghly Mail file that it has this format. You may have to
write a short program to convert from another format before
importing.

If you are exporting, you may need to export to a temporary

file, use a conversion program, then send the data on to the
final destination.

Quitting Mighty Mail
‘When you click on this option under the File menu, Mighty

Mail will close the current working file, then return you to
the GEM Desktop.
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Using the Layout menu

You may use the options from this menu to design layouts
for your labels and reports, and to save your layouts and
recall them for later use.

SAHPLE File [EITIIEN Hasks Printer

To design a label or a report, you’ll drag into place on the
label or report display area the boxes labeled with the
names of the elements of the data you want printed.
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Defining a label or report

‘When you click on DEFINE under either Labels Layout or
Reports Layout, you’ll see a screen divided horizontally in
two, with the upper, larger section subdivided. You’ll use
the upper portion to design the position of the data
elements, the lower portion to describe the size and shape of
the labels or reports themselves.

Libel fe h
el Helont: 6.
Repeat font: 12 wien R )

and the Reports screen differs only in the lower portion:

Page deader: Tin's Phan
Printes Lines Per Page:

Pause between pges 0D s 38 -
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LAYING OUT A LABEL

At the bottom of the screen you’ll see four blanks to fill in
to describe your label stock to the computer. You’ll need to
fill in the number of labels across each row, the number of
characters between the beginning of the first and the
beginning of the second label, the number of lines from the
top of the first row of labels to the top of the second row,
and the number of times you want to print each label.

To do so, click on the blank you want to fill and type the
number. “The usual GEM editing keys work, except that
RETURN moves the cursor to the next data field.

Now you're ready to design how the label components will
be placed on each label. First, decide whether you need the
screen display to be 80 or 160 columns wide while you
design. For most Iabels, 80 columns is enough since you’re
laying out only one label template, not a whole row of
labels. Two selector buttons at the lower right of the screen
are labeled 80 COLS and 160 COLS. Click on the
appropriate selector button to change to the other width.

The upper section of the screen is divided into two parts.
‘The upper part is initially blank and the lower part contains
boxes labeled with the names of all the data fields stored in
the data files.

To place a data field on the label, click on and drag the
appropriate box from the lower to the upper part of the
screen. If you want to skip printing any of the data, leave it
below the dividing line.

If you place two boxes so that they touch horizontally,
excess spaces will be closed up when the label is printed.

‘When you’ve laid out the label as you like, click on the OK'

selector button or press CTRL-RETURN. To abandon the
design, click on CANCEL.
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LAYING OUT A REPORT

Laying out a report is much like laying out Iabels, except
that the report is assumed to be a full page width.

To begin, fill in the information at the bottom left. Click on
the appropriate line and type in what you want. First, type
in a header to be printed at the top of each page. Then type
in the number of lines you want printed on each page and
the number of lines each page is long. The usual GEM
editing keys work, except that RETURN moves the cursor
to the next data field. Click on the 80 COLS or 160
COLS selector button to set an appropriate width.

If the number of lines per page is larger than the
number of printed lines per page, Mighty Mail sends a
form feed instruction to the printer to quickly get the
next page ready to go.

To lay out the data fields on the report form, click on and
drag the labeled boxes to the position in the upper part of
the screen you want them on the report. If some of the data
s not to appear on the report, leave it in the lower part of
the screen.

When you are happy with the layout, click on the OK
selector button or press CTRL-RETURN._ If you decide to
abandon the report design, click on the CANCEL selector
button instead.
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Saving the design

To save your label or report design to disk so you can use it
again, click on the appropriate SAVE option on the Layout
menu. Mighty Mail will show you an item selector box.

To replace a listed file

To replace the layout in one of the listed files, click on its
Iabel, then on OK, or double-click on the file label. Mighty
Mail will erase the layout now stored in the file and replace
it with the layout just designed.

To replace a file not listed

If the layout file you want to replace is on another disk
drive, click once on the directory line at the top, then type in
the right disk drive designation, using the usual GEM
editing keys. Click once on the folder identifier move bar
to see the files in the newly chosen folder.

If the file you want is contained within a folder in the
current folder, double-click to open the folder. You may
open as many folders within folders as necessary.

To create a new layout file

To store o layout under a new name, just type the name
into the Selection blank at the right of the selector box.
Click on OK. Mighty Mail will save the new file and will
list it when you next ask to load a label or report file.
Mighty Mail gives label files the extension .LBL and report
files the extension .REP.
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Loading a design

When you click on Load under either the Reports or
Labels sections, you’ll see an item selector listing the
layouts currently stored on the default drive. Reports files
all have the cxlensmn .REP; label files all have the
extension .LBL. Mlghty Mail loads, it loads the
files DEFAULT. LBL and DEFAULT.REP.

To choose a listed file

To choose one of the listed files, click on its label, then on
OK, or double-click on the file label. Mighty Mail will
load the chosen layout, ready to use it to print the labels or
reports.

To choose a file not listed

If the file you want to use is on another disk drive, click
once on the directory line at the top, then type in the right
disk drive designation, using the usual GEM editing kays
Click once on the folder identifier move bar to see the files
in the newly chosen folder.

If the file you want is contained within a folder in the

current folder, double-click to open the folder. You may
open as many folders within folders as necessary.

Mighty Mail - Page 31



Using the mask menu

The Mask menu helps you print selected portions of your
‘mailing list on either reports or labels. You'll be able to
create masks to control which records are printed by sorting
alphabetically on any typed data field, on any user-defined
flag setting, or on any combination. Most of the time, just
one or a few criteria will suffice.

Mighty Mail remembers the last mask of each type.
Setting up a mask

‘When you click on either Low Mask or High Mask, you’ll
see a screen much like the View screen, except that the

selector buttons on the right will be limited to CANCEL
and ACCEPT. The central stripe on the screen will show

To set up a mask, just turn on any user-defined flags you
want to select on, then type into the appropriate data fields
the limiting values you want to select on. The usual GEM
editing keys work, except that RE TURN moves the cursor
from field to field.
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SETTING UP A LOW MASK

When you turn on one of the user-defined flags in the low
mask, Mighty Mail will print out only those records which
also have the same flag turned on. If you turn on several
flags, Mighty Mail will print out only those that have all of
those same flags turned on.

If you leave a data field blank, Mighty Mail will not sort
the records based on that field. If you type anything into a
data field, Mighty Mail will print only those records that
match or follow behind the typed data in alphabetical order.
If you type into several data fields, Mighty Mail will print
only those records for which the data in the corresponding
fields all match or follow alphabetically the data in the
‘mask fields.

For instance, if you type Jones into the personal last
name field and Phoenix into the city field, Mighty
Mail will print a label for Mr. Kirschbaum in Seattle,
but it will not print a label for his mother in Dallas.

If you fill in some data fields and turn on some user-defined
flags, Mighty Mail will print only those records that pass
oth tests.

You may use the ?and *wild cards in masks; you’ll find
them useful in dealing with numerical data, like zip codes.
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SETTING UP A HIGH MASK

Because you can select records according to flags set by
using the low mask, the high mask flag seftings are used for
another function: As each record i is printed, the status of
each flag set on in the high mask is changed to off. This
characteristic is handy when you want to print labels once
only, but use more than one mask to find the records to use.

‘The data field settings in the high mask, though, work as the
mirror image of the low mask settings. If you leave a data
field blank, Mighty Mail will not sort the records based on
that field. If you type anything into a data field, Mighty
Mail will print only those records that precede the typed
data in alphabetical order. If you type into several data
f‘elds, Mlghfy Mail will print only those records for wmch
data in the comesponding fields all prec
a.lphabeucauy the data in the mask fields.

For instance, if you type Fred into the personal first
name field, Mighty Mail will print a label for anyone
named Bob, but it will not print labels for those named
Robert.

You may use the ?and *wild cards in masks; you'll find
them useful in dealing with numerical data, like zip codes.
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Setting up an autotype mask

‘When you’re adding new records to your file manually,
you’ll sometimes have a group with a shared characteristic,
like state of residence, or a partially-shared characteristic,
like the first three zip code digits. You may use the
Autotype feature of Mighty Mail to automatically type the
shared features into each record, leaving the record ready
for you to finish in less time.

When you click on the Autotype option under the Masks
‘menu, you’ll see a screen similar to the View screen, except
r.hat the ?nons on the right will be limited to ACCEPT and

To set up an Autotype mask, simply type in the shared
values or partial values into the appropriate data fields. The
usual GEM editing keys work, except that RETURN will
move the cursor from one field to the next. For instance, if
you were doing the mailing list for the Jimmy Smith Club,
Whose members are all named Jimmy Smith, you'd fill in
the name fields. Then click on any user-defined flags you
want to set for the group. When you have everything
correct, click on OK or press CTRL-! RETURN Or chck on
CANCEL to leave the Autotype mask as it was.
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Labeling flag descriptions

‘When you use Mighty Mail for the first time, the 16 user-
defined flags will be active, but the labels will just be the
number 7-76. You may use the Flag Descriptions option
under the Masks menu to change the labels to something
‘more meaningful.

You may type any label you like for each of the flags. The
usual GEM editing keys work, except that RETURN moves
the cursor from one data field to the next. Because of space
limitations on the display screen, the labels are limited to
eight characters.

When you have labeied the flags you want, click.on OK or

press CTRL-RETURN. The new set of labels will be used
until you change them with this option.
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Using the Printer menu

‘When you want to print labels or a report, the usual
sequence is to open your address file, choose or design a
layout, set up masks to select just the records you want
printed, and then use the Printer menu to set the printer in
motion.

You may either print directly to your printer, or "print" to a
disk file either to create selected data files or to save for
physical printing later or to use in a word processing
program.

Printing a set of labels
When you have chosen the data file, the layout and the

masks to use, click on Print Labels. You’ll see a dialogue
box that asks if you want to print a row of test labels.

SPLE  File Lyouts Mesks [HURT

T ot e
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If you click on YES, Mighty Mail will immediately
print one row of labels in the current format, with an
asterisk substituted for each character of the data fields.
This feature is handy to check that the layout fits
properly on the current label stock and that the label
stock is lined up comectly both vertically and
horizontally.

If you click on ABORT, the printing operation will be
suspended and you’ll be returned to the main menu.

If you click on NO, the printing of the selected labels
will begin immediately.

As the labels are printed, Mighty Mail will display a box
showing progress through the data records. If you want to
stop the printing, press and hold either SHIFT key or the
mouse button until the printing stops. When printing is
done, you’ll be returned to the main menu.
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Printing a report

When you have the preliminaries out of the way, click on

Print Report to begin. You’ll see an alert box that asks you

whelher to pause between pages for a paper change. Chck
YES or NO as appropriate for your printer.

‘begins immediately.

As the report is printed, Mighty Mail will display a box
showing progress through the data records. If you want to
stop the printing, press and hold either SHIFT key or the
mouse button until the printing stops. When printing is
done, you’ll be returned to the main menu.

Printing labels or reports to a file

When you have the preliminaries out of the way, click on
Print Labels to File or Print Report to File as appropriate.
You’ll see a standard item selector box listing the files with
extension .PRT on the default disk drive.

To print to a listed file

To print on one of the listed files, click on its label, then on
OK, or double-click on the file label. Mighty ‘Wail will
open the specified file and print the selected records at the
end of the current data on the chosen file. A dialog box will
show the progress of the printing operation. You may stop
the printing by pressing and holding either SHIFT key or
the mouse button until the program stops. When printing is
finished, you’ll be returned to the main menu.
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To print to a file not listed

If the file you want to print on is on another disk drive, click
once on the directory line at the top, then type in the right
disk drive designation, using the usual GEM editing keys.
Click once on the folder identifier move bar to see the files
in the newly chosen folder.

If the file you want is contained within a folder in the
current folder, double-click to open the folder. You may
open as many folders within folders as necessary.

Once you have the right disk drive and folder, double-click
on the file name or click once on the file name and once on
OK'to begin. Printing to the file will begin immediately, A
dialog box will show the progress of the printing operation.
You may stop the printing by pressing and holding either
SHIFT key or the mouse button until the program stops.
When printing i finished, you'll be retumned to the main
menu.

To print to a new file

If you want to create a new file, change to the disk drive
and directory you want to use, if necessary, and type in the
name of the new file in the Selection blank at the right of
the screen. Click on OK. Printing to the file will begin
immediately. A dialog box will show the progress of the
printing operation. You may stop the printing by pressing
and holding either SHIFT key or the mouse button until the
program stops. When printing is finished, you'll be
returned to the main menu.
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